Table of Contents

**Welcome to Version Manager** ................................................. 7
Typographical Conventions .......................................................... 7
Contacting Technical Support .......................................................... 8

**Chapter 1**

**Version Manager Web Client Basics** ........................................ 9
Introducing the Version Manager Web Client ...................................... 10
Version Manager Web Client Features .............................................. 10
Version Manager Web Client Components .................................... 11
Using the Version Manager Web Client with
Version Manager .................................................................................. 11
Using TrackerLink (Tracker) with the Version Manager Web Client ... 13
  Using TrackerLink ........................................................................... 13
Using SourceBridge (TeamTrack) with the Version Manager Web Client . 15
  Using SourceBridge ....................................................................... 15
Using the Version Manager Web Client with Previous Releases ........ 17
System Requirements ........................................................................ 18

**Chapter 2**

**Getting Started** ........................................................................ 19
Connecting to the Version Manager Web Client .................................. 20
Logging In to a Project Database ....................................................... 20
  Regular Login .............................................................................. 20
  Single Sign On / Common Access Card Login .................................. 22
Changing Your Password .................................................................. 23
Switching Users .............................................................................. 24
Logging Out of a Project Database .................................................... 25
Managing the Web Client Applet ....................................................... 26

**Chapter 3**

**Navigating the Interface** ............................................................. 27
Version Manager Web Client Panes ................................................. 28
  Working in the Project Pane ......................................................... 28
  Working in the Content Pane ....................................................... 29
  Working in the Revision Pane ...................................................... 30
  Working in the Menu Pane .......................................................... 32
  Working in the Status Pane .......................................................... 34
Selecting Items ................................................................................. 35
Moving Items .................................................................................... 36
Renaming Items ................................................................................ 37
# Table of Contents

## Chapter 3

- Deleting Items ............................................. 37
- Reviewing Item Properties ................................. 38
- Filtering Your View ........................................ 39
  - Viewing Files Recursively ............................... 40
  - Filtering by Locker ...................................... 40
  - Filtering by Wildcard Filename .......................... 41
  - Filtering by Version Label .............................. 42
  - Filtering by Promotion Group ............................ 44
  - Filtering by Comparing Two Version Labels .......... 45
  - Filtering by Comparing Two Promotion Groups ....... 47
  - Filtering by Comparing a Version Label and a Promotion Group ........................................ 49

## Chapter 4

**Customizing Your Environment** .......................... 53

- Setting Version Manager Web Client Options .............. 54
  - Default Version Manager Web Client Options ........... 54
  - Setting Number of Items per Page ....................... 55
  - Specifying a Delimiter for Items Entered in Fields .... 55
- Defining Check In/Check Out Options ....................... 56
- Defining Revision Lookup Behavior ......................... 57
- Including Subprojects in Project Operations ............. 57
- Dismissing Results Dialog Boxes after Successful Action 58
- Setting Your Default Editor ............................... 58
- Specifying a Difference or Merge Tool ................... 59
- Passing Options Based on Ignore White Space ............ 61

## Chapter 5

**Comparing Files** ........................................... 69

- About Comparing Files .................................... 70
- Viewing Differences ...................................... 70
- Interpreting Difference Results .......................... 72
  - Difference Examples .................................... 73

## Chapter 6

**Merging Files** ............................................... 75

- About Merging ............................................. 76
  - Merging Terms and Definitions ........................... 76
  - The Merge Process ...................................... 77
  - Selecting a Base File .................................... 77
- Merging Files in Windows or UNIX ......................... 77
- Interpreting Difference Results in Windows ............. 81
  - Placeholders ........................................... 81
  - Conflicts ................................................ 82
- Interpreting Difference Results in UNIX ................. 83
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placeholders</td>
<td>84</td>
</tr>
<tr>
<td>Resolving Conflicts Between Files in Windows</td>
<td>84</td>
</tr>
<tr>
<td>Resolving Conflicts Between Files in UNIX</td>
<td>85</td>
</tr>
<tr>
<td><strong>Appendix A: Naming Conventions and Restrictions</strong></td>
<td>87</td>
</tr>
<tr>
<td>General Naming Conventions and Restrictions</td>
<td>88</td>
</tr>
<tr>
<td>Prohibited Characters for Files and Directories</td>
<td>88</td>
</tr>
<tr>
<td>Naming Considerations for Cross-Platform Environments</td>
<td>88</td>
</tr>
<tr>
<td>Specific Naming Conventions and Restrictions</td>
<td>89</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>91</td>
</tr>
</tbody>
</table>
Welcome to Version Manager

Thank you for choosing the Serena® PVCS® Version Manager™ web client, a powerful and versatile version control system that will revolutionize the way that you develop software. Version Manager helps you organize, manage, and protect your software development projects on every level—from storing and tracking changes to individual files, to managing and monitoring an entire development cycle.

Purpose of this manual
This manual introduces you to browser-based interface, highlights differences between the Version Manager web client and the Version Manager desktop client, and provides instructions on how to get started using Version Manager web client. This manual supplements the Serena PVCS Version Manager User's Guide, which is designed to be the primary source of information about Version Manager features and concepts, and the Version Manager web client online help.

Once you start using the Version Manager web client, access the online help for detailed instructions on how to perform daily tasks, such as checking out files, managing version labels, and adding workfiles to projects.

For more information
Refer to the Serena PVCS Version Manager Getting Started Guide for a description of the Version Manager documentation set, a summary of the ways to work with Version Manager, and instructions for accessing the online help.

Edition status
The information in this edition applies to Release 8.4.6 of Version Manager Web Client or later. This edition supersedes earlier editions of this manual.

Typographical Conventions
The following typographical conventions are used in the online manuals and online help. These typographical conventions are used to assist you when you use the documentation; they are not meant to contradict or change any standard use of typographical conventions in the various product components or the host operating system.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>italics</td>
<td>Introduces new terms that you may not be familiar with and occasionally indicates emphasis.</td>
</tr>
<tr>
<td><strong>bold</strong></td>
<td>Emphasizes important information and field names.</td>
</tr>
<tr>
<td>UPPERCASE</td>
<td>Indicates keys or key combinations that you can use. For example, press the ENTER key.</td>
</tr>
<tr>
<td>monospace</td>
<td>Indicates syntax examples, values that you specify, or results that you receive.</td>
</tr>
<tr>
<td>monospaced <em>italics</em></td>
<td>Indicates names that are placeholders for values you specify; for example, <em>filename</em>.</td>
</tr>
<tr>
<td>monospace <strong>bold</strong></td>
<td>Indicates the results of an executed command.</td>
</tr>
</tbody>
</table>
### Contacting Technical Support

Registered customers can log in to [http://support.serena.com/](http://support.serena.com/).

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>vertical rule</td>
<td>Separates menus and their associated commands. For example, select File</td>
</tr>
<tr>
<td>brackets []</td>
<td>Indicates optional items. For example, in the following statement: SELECT [DISTINCT], DISTINCT is an optional keyword.</td>
</tr>
<tr>
<td>...</td>
<td>Indicates command arguments that can have more than one value.</td>
</tr>
<tr>
<td>Shows you which shortcut button to click. Shortcut buttons are placed in the margin.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1

Version Manager Web Client Basics

Introducing the Version Manager Web Client 10
Version Manager Web Client Features 10
Version Manager Web Client Components 11
Using the Version Manager Web Client with Version Manager 11
Using TrackerLink (Tracker) with the Version Manager Web Client 13
Using SourceBridge (TeamTrack) with the Version Manager Web Client 15
Using the Version Manager Web Client with Previous Releases 17
System Requirements 18
**Introducing the Version Manager Web Client**

The Serena PVCS Version Manager web client is the web-based client component of Version Manager that allows you to access Version Manager projects via the Internet or intranet. The Version Manager web client works with the Version Manager Server, the web-based server component of Version Manager.

With the Version Manager web client, you can use your web browser to view detailed information about projects and archives, and to perform such tasks as checking in and checking out files, managing locks, version labels and promotion groups, and running reports.

Because the Version Manager web client allows you to access Version Manager projects from any connected point on the Internet or intranet, it's ideally suited for remote users, mobile users and users in web-intensive environments, such as members of Internet programming and content development teams.

In addition, the lightweight web browser interface offers the benefits of a very low cost of maintenance for users and administrators in all environments.

**Version Manager Web Client Features**

The Version Manager web client provides the essential end-user version control features of Version Manager. It is designed for users who do not need access to administrative features.

The Serena PVCS Version Manager web client online help provides detailed procedures for using these features.

The Version Manager web client provides the following features:

- **Add Workfiles.** Add one or more workfiles to a project database or project. You can also add an entire directory with subdirectories, which becomes a project with subprojects in the project database.

- **Create Projects.** Manually create new projects with a different directory structure than the existing workfile structure.

- **Check in** and **Check out.** Check files in to and out of archives.

- **Get.** Get copies of revisions without checking them out.

- **Lock** and **Unlock.** Lock and unlock revisions of files.

- **Version Labels.** Assign, change, and delete version labels.

- **Promotion Groups.** Promote revisions, and to assign, change, and remove promotion groups.

- **History Reports.** Run reports that show detailed information on archives.

- **Difference Reports.** Compare two revisions or two workfiles, or compare a workfile and a revision.

- **Merge Files.** Merge two revisions or two workfiles, or a workfile and a revision.

- **Options.** Set default dialog box and display options.
Version Manager Web Client Components

- **Copy and Move.** Copy or move versioned files between projects in a project database.
- **Workspaces.** Set, create, rename, and delete public or private workspaces.
- **Rename.** Change the names of projects and Version Manager 5.3/6.0 folders in the interface.
- **Delete.** Remove projects, Version Manager 5.3/6.0 folders, and versioned files from the interface.
- **Change Password.** Change the password you use to log in to a project database. This also changes your password in Version Manager if an Access Control Database is in place.

**Version Manager Web Client Components**

The combined services of the Version Manager Server component, a supported web server, and the Version Manager web client component provide access to your archives via the Internet or an intranet.

Before you can use the Version Manager web client, your Serena products administrator must install the Version Manager Server component on a system that is running a web server. Once the Version Manager Server is configured for use with Version Manager projects, you can log into the Version Manager web client interface and view detailed information about projects and perform actions from within your web browser.

**Using the Version Manager Web Client with Version Manager**

You must use Version Manager to perform all administrative tasks on project databases. Administrative tasks can include creating and configuring project databases or roots, defining security, and setting up promotion models.

Most end-user tasks in the Version Manager web client, such as checking out files or adding workfiles, follow the same procedures as those in the Version Manager desktop client. These procedures are documented in the Version Manager Web Client online help. However, some differences do exist for tasks involving version labels and promotion groups.

**Version Labels and Promotion Groups**

When working with version labels and promotion groups in Version Manager, you choose the specific operation you want to perform from the menu. For example, you choose Actions | Version Label | Assign to assign a version label or Actions | Promotion Group | Remove to remove a promotion group.

In the Version Manager web client, you perform all operations with version labels and promotion groups by selecting the Label button or Promote button on the Actions menu. At the top of the Version Label or Promotion Group dialog box, you select which operation you want to perform. The contents of the dialog box change with your selection.
For example, if you select Actions | Label, the dialog box appears as below. By default, the **Assign** option is selected and the contents of the dialog box correspond to that operation.

![Version Label Project - bridge](image)

**NOTE** It is best practice to use version labels that do **NOT** look like revision numbers.

If you select the **Rename** option, the contents of the dialog box change:

![Version Label Project - bridge](image)
Using TrackerLink (Tracker) with the Version Manager Web Client

You can use TrackerLink in the Version Manager web client or desktop client to associate workfiles with issues in Serena Tracker. Use TrackerLink as a tool to bridge Tracker and Version Manager. When checking in, checking out, locking, or adding workfiles, you can associate those workfiles with issues through the TrackerLink Workfile Association dialog box.

Configuring TrackerLink

Before you can use TrackerLink, your administrator must:

- Configure TrackerLink options. See the Serena PVCS Version Manager Administrator’s Guide.
- Associate the servlet for your Version Manager project database with the URL of a Tracker database. See the Serena PVCS Version Manager Administrator’s Guide.

Using TrackerLink

Use TrackerLink to associate issues with workfiles when you:

- Check out a file
- Check in a file
- Lock a file
- Add new workfiles

If your settings do not automatically log you in to Tracker, you will be prompted for your login information when you associate workfiles.

To associate an issue with a workfile on check in, check out, adding workfiles, or on locking a file:

1. Select the files you want to associate with issues.
2. Make the check in, check out, add workfiles, or lock request.
3 Click the **Associate Issues** button on the Check Out, Check In, Lock, or Add Workfiles dialog boxes. The TrackerLink Workfile Association dialog box appears.

4 Select a query from the **Queries** pane to run a query to find and select the issues to associate with your workfiles or find them in the In Tray.

5 From the **Workfiles** pane, select the files to associate with an issue.

6 Double-click the first issue number to associate with your workfile. This associates that issue with the workfile, and the number that appears to the left of the workfile name increases by one. You can also choose the **Associate** button to associate the issue and your workfile.

7 Double-click the workfile name to see the currently associated issues. If its title and description appear, the issue is currently selected.

8 If you change your mind about a particular association, you can:
   - Double-click the issue number in the Workfiles pane to unassociate it.
   - Select the issue and click the Unassociate button.

   **NOTE** You can associate several files with one issue at the same time, but you cannot select a query and associate all of its matching issues with a workfile or workfiles at the same time. Issues must be selected individually.

   If a file has no associations, the current workfile will have a plus sign next to it. When you select it, it will appear with "(no associations)" below it.
Using SourceBridge (TeamTrack) with the Version Manager Web Client

**Launching the Tracker Web Client**

You can access the Tracker web client by clicking the Tracker icon on the Actions tab.

**Using SourceBridge (TeamTrack) with the Version Manager Web Client**

You can use SourceBridge in the Version Manager web client or desktop client to associate workfiles with issues in Serena TeamTrack. When checking in, checking out, locking, or adding workfiles, you can associate those workfiles with issues in TeamTrack.

**Configuring SourceBridge**

Before you can use SourceBridge, your administrator must:

- Configure SourceBridge options. See the *Serena PVCS Version Manager Administrator's Guide*.
- Associate the servlet for your Version Manager project database with the URL of a TeamTrack database. See the *Serena PVCS Version Manager Administrator’s Guide*.

**Using SourceBridge**

Use SourceBridge to associate issues with workfiles when you:

- Check out a file
- Check in a file
- Lock a file
- Add new workfiles

**To associate an issue with a workfile on check in, check out, adding workfiles, or on locking a file:**

1. Select the files you want to associate with issues.
2. Make the check in, check out, add workfiles, or lock request.
3  Click the **Associate Issues** button on the Check Out, Check In, Lock, or Add Workfiles dialog boxes. SourceBridge will opens.

![SourceBridge Web Client Screenshot](image)

**Search**

- **Project (include Sub-Projects):** Select a TeamTrack project.
- **Keywords:** Enter keywords to search for. You may use the percent symbol (%) as a wildcard.
- **Show Only Items I Own:** Select this check box to limit the search to items that you own.
- **Item ID:** Enter the ID of the item(s) to search for. You may use the percent symbol (%) as a wildcard.
- **Append Search Results to List:** Select this option to append new search results to any existing items in the Results pane. If this option is not selected, any existing results will be replaced when you run a new search.
- **Filter on Active/Inactive:**
  - **Active:** Select this option to search for only those items that are active.
  - **Inactive:** Select this option to search for only those items that are inactive

**Results**

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Title</th>
<th>Owner</th>
<th>Project</th>
<th>State</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUG00032</td>
<td>Undo button does not work 3 deep</td>
<td>Joe User</td>
<td>Animation Pro</td>
<td>New</td>
<td>Active</td>
</tr>
<tr>
<td>BUG00037</td>
<td>I'm losing frames of animation during a save</td>
<td>Joe User</td>
<td>Animation Pro</td>
<td>New</td>
<td>Active</td>
</tr>
<tr>
<td>BUG00012</td>
<td>Image Builder crashes my system</td>
<td>Joe User</td>
<td>Image Builder</td>
<td>New</td>
<td>Active</td>
</tr>
</tbody>
</table>

**Associations**

- **All Files**
  - fordeckbridge.dsw
  - fordeckbridge.ccp
  - fordeckbridge.dsp
  - fordeckbridge.dsw
  - fordeckbridge.h
  - fordeckbridge.nbc
  - fordeckfuture.cdr

**NOTE** To log in as a different user, click the **Logon** button.
• **Both:** Select this option to search for items regardless of whether they are active or inactive.

5 Click the **Search** button. The search results appear in the Results pane.

6 To view the details of a TeamTrack issue, click its ID. The issue will then open in the TeamTrack web client.

7 Select the check box next to the issue(s) that you want to associate with items under source control.

8 From the Associations pane, select the files to associate with the selected issues.

9 Click the **Associate** button to associate the selected issues and workfiles. The associations are then displayed in the Associations pane.

10 To remove an association, select the issue in the Associations pane and click the **Unassociate** button.

11 Click the **Done - Continue with . . .** button.

**Launching the TeamTrack Web Client**

You can access the TeamTrack web client by clicking the:

- TeamTrack icon 🕹️ on the Actions tab of the Version Manager web client.
- Issue ID in the Results pane of the SourceBridge associate dialog.

**Using the Version Manager Web Client with Previous Releases**

You should upgrade Version Manager 5.3/6.0 project roots to the current format using Version Manager. However, you can still access 5.3/6.0 project roots in the Version Manager web client without upgrading them. While most functionality is supported in this scenario, some restrictions apply to ensure compatibility with the Version Manager 5.3/6.0 GUI.

You cannot:

- Create, delete, or rename projects within the Version Manager 5.3/6.0 project root. However, you can perform these actions on 5.3/6.0 folders.
- Add multiple directories. You can add a single directory by selecting all of the files within it.
- Automatically see newly added archives in the content pane. You must use the Update Project Folder option to update the display if archives have been added in other interfaces, such as the command-line interface.
Chapter 1  Version Manager Web Client Basics

System Requirements

The Version Manager web client is supported on Windows and UNIX operating systems. For specific supported platform, web browser, and version information, refer to the readme file (readmevm.htm).
## Chapter 2

### Getting Started

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting to the Version Manager Web Client</td>
<td>20</td>
</tr>
<tr>
<td>Logging In to a Project Database</td>
<td>20</td>
</tr>
<tr>
<td>Changing Your Password</td>
<td>23</td>
</tr>
<tr>
<td>Switching Users</td>
<td>24</td>
</tr>
<tr>
<td>Logging Out of a Project Database</td>
<td>25</td>
</tr>
<tr>
<td>Managing the Web Client Applet</td>
<td>26</td>
</tr>
</tbody>
</table>
Connecting to the Version Manager Web Client

You connect to Version Manager web client to establish a link between your web browser and Version Manager project databases or roots. You must connect to the Version Manager web client before you can log into a project.

**TIP** If you know the URL of the project database, or if you have the location bookmarked in your web browser, you can open the URL directly without connecting to the Project Databases page. Optionally, bookmarks can include the specific project you want to open. For example: http://ServerName/SampleDB/chess/client.

**To connect to the web client:**

1. Start your web browser.
2. Open the URL of the Version Manager Web Client Project Databases page. The URL of this page is http://hostname:port/vminet.html (for non-secure web services) or https://hostname:port/vminet.html (for secure web services), where hostname is the name of the system hosting the Version Manager Server and port is the server port.

   The Project Databases page appears.
3. Click the name of the project database or root to which you want to connect in the Link list.

   **NOTE** You can also access the online documentation and the client applet management page from the Project Databases page.

After you have connected to the Version Manager Server, the Login page appears. Continue to the next section.

**NOTE** From an individual web client system, do not open more than one connection to a given Version Manager web server at a time. If you have multiple web servers, you can open a single connection to each server in its own browser tab or browser instance, but do NOT invoke more than one dialog at a time (for example, do not run Get dialogs from two tabs at the same time).

Logging In to a Project Database

Log in to a project database when you want to access Version Manager projects, 5.3/6.0 folders, and versioned files. To log in to a project database, you must have a valid user ID and password or Common Access Card and PIN. Typically, your administrator assigns user IDs and passwords.

The web client can present two different login screens, depending on how your project database is configure:

- Regular login
- Single Sign On / Common Access Card login
Regular Login

This is the traditional User ID and Password login.

To log in to a project database:

1. Open the Login page by connecting to Version Manager web client as described in "Connecting to the Version Manager Web Client" on page 20. The Login page appears.

2. Enter your user ID in the User ID field.

   **NOTE** If the project database is configured to use Host ID as the login source and:
   - A password is required, the User ID field will be prepopulated and uneditable.
   - A password is not required, the user will be logged in automatically and the login dialog box will not be displayed.

3. Enter your password in the Password field.

   **NOTE** If you have a password for the project database in the Version Manager desktop client, your web client password will match your desktop client password.

   For security reasons, the Input Method Editor is disabled in the Password field. You will not be able to enter double-byte characters in this field.
4 (optionally) To free licenses from any stale login sessions that you may have open, select **Automatically close all other sessions for your user ID on this server**.

5 Click **OK**.

You may also need to log in to a project if your administrator has configured an Access Control Database for it. In this case, the Login page appears when you select the project.

**To log into a project:**

1 Enter your user ID in the **User ID** field.

**NOTE** If the project database is configured to use Host ID as the login source and:
- A password is required, the **User ID** field will be prepopulated and uneditable.
- A password is not required, the user will be logged in automatically and the login dialog box will not be displayed.

2 Enter your password in the **Password** field.

**NOTE**
- If you have a password for the project in the Version Manager desktop client, your web client password will match your desktop client password.
- For security reasons, the Input Method Editor is disabled in the **Password** field. You will not be able to enter double-byte characters in this field.

3 Select the **Remember this user name/password** option to store this information so that you don’t have to log in to the project for future Version Manager web client sessions.

4 Click **OK**.

**Single Sign On / Common Access Card Login**

If your project databases are configured for this login type, you can login to one project database and not be prompted when accessing another. You may also access the SBM client without logging in again. Also, in addition to User ID and Password, this login page supports Common Access Card (SmartCard) and PIN login.

**NOTE** You will see this page and these login options only if the project database you are attempting to access has been configured to support these login sources. See the Version Manager Administrator’s guide.

**To log in to a project database:**

1 Open the Login page by connecting to Version Manager web client as described in "Connecting to the Version Manager Web Client" on page 20. The Login page appears.

2 Do one of the following:
- For User ID and Password based SSO login, complete the **User Name** and **Password** fields and click the **Log In** button.
- For Common Access Card and PIN based login, click the **SmartCard Login** button. A dialog appears from your third party SmartCard utility:
Changing Your Password

You can change the password assigned to you by your administrator at any time. The password you change is the one that you entered in the Login page. Once you’ve changed your password, the new password takes effect the next time you log into the Version Manager web client.
If security is enabled in Version Manager for this project database, changing your password in the Version Manager web client changes it in the desktop client as well (and vice-versa).

**To change your password:**

1. On the File menu tab, click the **Change Password** button. The Change Password dialog box appears.

   **Change Password**

   - Old password: 
   - New password: 
   - Verify new password: 

   ![Change Password dialog box]

2. Enter your current password in the **Old password** field.
3. Enter your new password in the **New Password** field, up to 29 characters.
4. Re-enter the new password in the **Verify new password** field.
5. Click OK.

### Switching Users

You can continue to work with an open project database or project using a different user name and password. The Switch User option provides a quick way to switch to a user ID with different privileges without having to close and reopen the project database.

This option is only available if the Administrator has configured the project database, project, or subproject using the Login dialog security option.

**To switch users for a project database or project:**

1. On the File menu tab, click the Switch User button.
The Switch User dialog box appears.

### Switch User

User ID: 

Password: 

Project Database: **Sample Project Database**

*(D:\Merant\vmicommon\SampleDB)*

---

2 Enter the new user ID in the **User ID** field.

3 Enter the password in the **Password** field, if required.

4 Click OK.

---

### Logging Out of a Project Database

Log out of a project database when you are finished with your source control tasks or when you want to log in to a different project database. When you log out of a project database, your Version Manager web client session is immediately terminated, requiring you to re-enter your user ID and password the next time you want to access a Version Manager project database.

**To log out of a project database:**

- Click the Logout button, located on the right side of the tabbed menus. The Logout page appears.
- To log into a different project database, click the vminet.html link to view a list of project databases available on this server.

---

**NOTE** Depending on your servlet configuration, if you do not explicitly log out of a project database, a time logout based on inactivity may occur.
Managing the Web Client Applet

You can remove existing applet installations and specify the applet installation location.

**NOTE** To uninstall pre 8.4.5 applets, use your operating system's program management utility (e.g. "Add or Remove Programs" or "Programs and Features"), or use the Add-ons/Plugins feature in FireFox or Mozilla.

To manage web client applets:

1. Open the Version Manager Web Client Configuration page. You can click the link from the Version Manager Project Databases page, or directly enter the URL:

   http://YourServer:Port/vminet_install.html

   **NOTE** If you wish to remove the currently running applet, you must close all browser instances and not open a Version Manager project before opening the Version Manager Web Client Configuration page.

2. Do any of the following:

   - **Uninstall an Applet:** Click the **Remove** link for the applet you wish to uninstall.
   - **Uninstall all Applets:** Click the **Uninstall All Applets** link to uninstall all applets that are 8.4.5 or newer.
   - **Apply Default Location:** Click the **To Default** link to use the default Version Manager applet location for future installations.
   - **Specify Custom Location:**
     - a. Select the **Custom** option.
     - b. Enter or browse to the desired location for future installations.
     - c. Click the **Apply Custom** link.
Chapter 3
Navigating the Interface

Version Manager Web Client Panes .................................................. 28
Selecting Items .............................................................................. 35
Moving Items ................................................................................. 36
Renaming Items .............................................................................. 37
Deleting Items ................................................................................ 37
Reviewing Item Properties ............................................................... 38
Filtering Your View ......................................................................... 39
Version Manager Web Client Panes

Once you have logged in to a project database, navigate the Serena PVCS Version Manager web client interface to view the projects, subprojects, 5.3/6.0 folders, versioned files, and revisions contained in the project database. Five panes comprise the Version Manager web client interface: the Project pane, Content pane, Revision pane (not shown below), Menu pane, and Status pane.

Working in the Project Pane

The Project pane displays the open project database and its projects, subprojects, and 5.3/6.0 folders in a hierarchical tree. Click +/- to expand or collapse the tree. When you select a project, subproject, or 5.3/6.0 folder, its versioned files appear in the Content pane to the right.

The following icons can appear in the Project pane:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Project Icon" /></td>
<td>The open project database displayed by its name and its location in parenthesis. A 5.3/6.0 project database displays by its location only.</td>
</tr>
<tr>
<td><img src="image" alt="Folder Icon" /></td>
<td>A project, subproject, or folder. The icon for a 5.3/6.0 project or folder appears in blue.</td>
</tr>
</tbody>
</table>
Working in the Content Pane

The Content pane displays the versioned files contained in the project database or project that you selected in the Project pane. To:

- Select versioned files for action, click the check boxes next them.
- Edit or view a versioned file in the default editor or browser, click the file icon.

- Open the Revision pane and view details on all of the revisions in a versioned file, click the file name.
- Sort the versioned files, click the heading of the column you wish to sort by. To inverse the sort order, click the column heading again.

The Content pane contains the following fields and icons:

<table>
<thead>
<tr>
<th>Field or Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents of</td>
<td>Displays the name of the project database or project in which the versioned files reside.</td>
</tr>
<tr>
<td>Workfile Location</td>
<td>Displays the project's workfile location</td>
</tr>
<tr>
<td>Page</td>
<td>Only displays when more items exist than can be contained on the page. Click Previous, Next, or [number] to go to the previous, next, or specific page. Click Index to go to the Page Index on the bottom, which lists the first and last files on each page. This field is duplicated at the bottom of the page, except the Index link is replaced by Top, which takes you to the top of the page.</td>
</tr>
<tr>
<td>Select/Deselect</td>
<td>Options to select and clear all items. If more items exist than can be contained on the page, you can choose to select all items on the current page.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the versioned file. Click to open the Revision pane.</td>
</tr>
<tr>
<td>Date Checked In</td>
<td>The date and time the versioned file was last checked in.</td>
</tr>
<tr>
<td>Locked By</td>
<td>The user ID that currently holds a lock on the item.</td>
</tr>
<tr>
<td>Checked Out To Location</td>
<td>If versioned file is checked out, displays the path the file is checked out to.</td>
</tr>
<tr>
<td>A versioned file that does not contain any locked revisions. view or edit the file in the default editor.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3 Navigating the Interface

Working in the Revision Pane

Once you click a versioned file link, the Revision pane appears. The Revision pane displays details on all revisions of the versioned file. To:

- Select a revision for action, click the check box next it.
- Edit or view a revision in the default editor or browser, click the revision number.

**NOTE** For information on setting the default editor, see "Setting Your Default Editor" on page 58.

- Sort the revisions, click the heading of the column you wish to sort by. To inverse the sort order, click the column heading again.

<table>
<thead>
<tr>
<th>Field or Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="image" /></td>
<td>A versioned file that contains a locked revision. view or edit the file in the default editor.</td>
</tr>
<tr>
<td><img src="image2.png" alt="image" /></td>
<td>A versioned file that references an archive that cannot be found.</td>
</tr>
</tbody>
</table>

Page Index Only displays when more items exist than can be contained on the page. It displays the page number and first and last files on each page.
The Revision pane contains the following fields and icons:

<table>
<thead>
<tr>
<th>Field or Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revisions of Workfile Location</td>
<td>Displays the name of the versioned file containing the revisions. Click the workfile location link to bring up the Set Workfile Location dialog box.</td>
</tr>
<tr>
<td>Page</td>
<td>Only displays when more items exist than can be contained on the page. Click Previous, Next, or [number] to go to the previous, next, or specific page.</td>
</tr>
<tr>
<td>Return to the contents of the project</td>
<td>Brings you back to the Content pane.</td>
</tr>
<tr>
<td>Revision</td>
<td>The number of the revision. The default revision is selected. Click to edit or view the revision in the default editor.</td>
</tr>
<tr>
<td>Author</td>
<td>The original author of the revision.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The timestamp on the file when it was last checked in.</td>
</tr>
<tr>
<td>Locked By</td>
<td>The user ID who currently holds a lock on the revision.</td>
</tr>
<tr>
<td>Description</td>
<td>The description added to the revision when it was checked in.</td>
</tr>
<tr>
<td>Labels</td>
<td>If a label is assigned to the revision, the label name displays.</td>
</tr>
<tr>
<td>Promotion Groups</td>
<td>If a promotion group is assigned to the revision, the promotion group displays.</td>
</tr>
</tbody>
</table>

- ![Revision Icon] A revision.
- ![Locked Revision Icon] A locked revision.
- ![Promotion Group Icon] A revision assigned a promotion group.
- ![Locked Revision with Promotion Group Icon] A locked revision assigned a promotion group.
- ![Version Label Icon] A revision assigned a version label.
- ![Locked Revision with Version Label Icon] A locked revision assigned a version label.
- ![Promotion Group and Version Label Icon] A revision assigned a promotion group and version label.
- ![Locked Revision with Promotion Group and Version Label Icon] A locked revision assigned a promotion group and version label.
Working in the Menu Pane

The Menu pane provides buttons to execute Version Manager web client commands. Click a tab to access the commands on the File, Edit, Actions, or Help menu. Click a button on the menu to execute a command.

The following menu buttons are available:

<table>
<thead>
<tr>
<th>File menu button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Creates a new project or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Sets or changes a workfile location for the selected project database, project, or versioned file.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Updates 5.3/6.0 project folders to display new archives added by other users.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Renames an existing project or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Deletes an existing project, 5.3/6.0 folder, or versioned file.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Displays the properties of a project database, project, 5.3/6.0 folder, or versioned file.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Sets, creates, renames, or deletes workspaces.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Switches to a different user ID for the selected project database or project.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Changes your password for logging into the selected project database or project.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit menu button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Copies one or more versioned files to another project or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>The archives remain in their original location.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Moves one or more versioned files to another project or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>The archives remain in their original location.</td>
</tr>
<tr>
<td>Actions menu button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Add workfiles" /></td>
<td>Adds workfiles to a project database, project, or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><img src="image" alt="Get revision" /></td>
<td>Gets a revision and makes a copy in the workfile location.</td>
</tr>
<tr>
<td><img src="image" alt="Check out" /></td>
<td>Checks out an editable revision to the workfile location.</td>
</tr>
<tr>
<td><img src="image" alt="Check in" /></td>
<td>Checks in a modified workfile to the archive.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock" /></td>
<td>Unlocks a revision without performing a check in.</td>
</tr>
<tr>
<td><img src="image" alt="Lock" /></td>
<td>Locks a revision without performing a check out.</td>
</tr>
<tr>
<td><img src="image" alt="Assign label" /></td>
<td>Assigns, renames, or deletes a version label from a revision.</td>
</tr>
<tr>
<td><img src="image" alt="Assign promotion group" /></td>
<td>Assigns, promotes, changes, or removes a promotion group from a revision.</td>
</tr>
<tr>
<td><img src="image" alt="Create history report" /></td>
<td>Creates a history report on a project database, project, versioned file, or 5.3/6.0 folder.</td>
</tr>
<tr>
<td><img src="image" alt="Launch Merge Tool" /></td>
<td>Launches the Merge Tool to compare (difference) revisions or workfiles.</td>
</tr>
<tr>
<td><img src="image" alt="Launch SBM" /></td>
<td>(May not appear.) Launches another web browser to bring up the SBM (TeamTrack) URL associated with the current project database. Your administrator defines this URL in the Version Manager Application Server.</td>
</tr>
</tbody>
</table>
Chapter 3 Navigating the Interface

Working in the Status Pane

The Status pane lets you view and modify your current filter, user ID, and workspace. It also displays the number of items that are currently selected. To:

- Change the display of versioned files in the Content pane, click the Filter list.
- Switch users, click the user ID.
- Set a different workspace, click the Workspace name.

(May not appear.) Launches another web browser to bring up the Tracker URL associated with the current project database. Your administrator defines this URL in the Version Manager Application Server.

(May not appear.) Launches TrackerLink so that you can associate workfiles with issues in Tracker when checking out, checking in, locking, and adding workfiles.

<table>
<thead>
<tr>
<th>Deployment menu button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Deployment" /></td>
<td>Requires Serena Mover to deploy files from Version Manager to another application.</td>
</tr>
<tr>
<td><img src="image" alt="Deployment" /></td>
<td>Requires Mover. Use to set up the file deployment.</td>
</tr>
<tr>
<td><img src="image" alt="Deployment" /></td>
<td>Requires Mover. Use to schedule the file deployment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help menu button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Launches the Version Manager web client help system.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Launches the What's New page in the help system. The What's New page communicates to you what features are new in this version of Version Manager.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Brings up the Serena support page.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Displays an About box with Version Manager web client copyright and version information.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Logs you out of the project database.</td>
</tr>
</tbody>
</table>
The Status pane consists of the following fields and icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>View all files or filter your view by filename wildcards, locker, version labels, or promotion groups. Retains the last four filters used.</td>
</tr>
<tr>
<td></td>
<td>Toggle between recursive and non-recursive filter modes:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Recursive:</strong> The Content pane displays all projects, subprojects, and versioned files contained within the item selected in the Project pane.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Non-recursive:</strong> The Content pane displays only the versioned files contained at the root of the item selected in the Project pane.</td>
</tr>
<tr>
<td></td>
<td>The current user ID displays here. Click the name to switch to another user ID for this project database.</td>
</tr>
<tr>
<td></td>
<td>The current workspace displays here. Click the workspace name to set a different workspace for this project database.</td>
</tr>
<tr>
<td></td>
<td>The workspace icon indicates if the workspace is public or private.</td>
</tr>
<tr>
<td></td>
<td>Displays the number of currently selected projects, folders, versioned files, or revisions. For versioned files and revisions, it also displays the total number of versioned files in the project and the number of revisions of a versioned file (for example, 4 of 50 files selected).</td>
</tr>
</tbody>
</table>

### Selecting Items

Select items in the Version Manager web client to view information on them, or to perform actions such as check in, get, check out, lock, unlock, or assign a version label. After you have selected the items, click a menu button to perform an action.

<table>
<thead>
<tr>
<th>To select...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The project database</td>
<td>Click the project database in the Project pane.</td>
</tr>
<tr>
<td>A project or folder</td>
<td>Click the project or folder in the Project pane.</td>
</tr>
<tr>
<td>Multiple projects</td>
<td>Press and hold the SHIFT or CTRL key while clicking the projects in the Project pane. You can only select multiple projects if they belong to the same parent project.</td>
</tr>
</tbody>
</table>
### Moving Items

You can move versioned files between projects or folders within a project database. When you move versioned files, the archives that they reference do not move. The versioned files continue to reference the archives in their original location.

Use the Version Manager desktop client to move other items, such as projects and folders.

**To move a versioned file:**

1. Select one or more versioned files.
2. On the Edit menu tab, click the **Move** button. The Move File dialog box appears.

3. Select the destination project or folder in the project navigation tree. To move the file directly beneath the project database or root, select the project database or root.

4. Click **OK**. The versioned file moves to the destination location.

<table>
<thead>
<tr>
<th>To select...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One or more versioned files</td>
<td>Click the check boxes next to the versioned files in the Content pane. To select all of the versioned files in a project, click the <strong>Select: All</strong> link. When versioned files exist on multiple pages, you can click the <strong>Select: All on this page</strong> to select the versioned files on the current page only. If you navigate to another page after clicking <strong>Select: All</strong>, the selection is canceled.</td>
</tr>
<tr>
<td>A revision</td>
<td>Click the radio button next to the revision in the Revision pane.</td>
</tr>
</tbody>
</table>
Renaming Items

You can rename a project or 5.3/6.0 folder in the Project pane. The new project name appears in both the Version Manager desktop and web clients, but the actual archive directory name is not changed.

**NOTE** You cannot rename versioned files or 5.3/6.0 projects.

If the previous workfile location matched the old project name, a new workfile location is set to match the new project name. You check out, copy, and check in files from the new workfile location. Any files checked out before you renamed a project or folder remain in the original workfile location.

**To rename a project or folder:**

1. Select the project or folder you want to rename.
2. On the File menu tab, click the **Rename** button.
   The Rename Project/Folder dialog box appears.
3. Enter the new name in the **Name** field.
4. Click **OK**.

Deleting Items

You can delete projects, 5.3/6.0 folders, and versioned files, depending on your security privileges. You cannot delete 5.3/6.0 projects. All deleted items are removed from both the Version Manager desktop and web clients. However, the archives of the deleted items are not removed from the archives directory. The project configuration file and access control database are also retained.
If you want to recover deleted projects, 5.3/6.0 folders, or versioned files, use Version Manager to import the archives into a project database or project.

**To delete a project, folder, or versioned file:**

1. Select the item you want to delete. You can select one or more projects, folders, or versioned files.
2. On the File menu tab, click the **Delete** button.
   The Confirm Delete dialog box appears.
3. Click **OK** to delete the item.

**Reviewing Item Properties**

You can review the properties of a project database, 5.3/6.0 project root, project, 5.3/6.0 folder, and a versioned file. Properties vary according to the item you select.

<table>
<thead>
<tr>
<th>If you select a...</th>
<th>You can...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project database or project</td>
<td>View its contents, configuration file, and archive location. You can also view or change the workfile location, default version, default promotion group, branch version, and base version.</td>
</tr>
<tr>
<td>5.3/6.0 project root or project</td>
<td>View its contents and configuration file. You can also view or change the default version, default promotion group, branch version, and base version.</td>
</tr>
<tr>
<td>5.3/6.0 folder</td>
<td>View its contents. You can also view or change the workfile location.</td>
</tr>
<tr>
<td>Versioned file</td>
<td>View archive information. You can also view or change the workfile location.</td>
</tr>
</tbody>
</table>
To view the properties of an item:

1. Select a project database, project, folder, or versioned file.
2. On the File tab, click the **Properties** button. The Show Properties dialog box appears.

3. View or change the default settings as necessary. See Chapter 4, "Customizing Your Environment" on page 53.
4. Click **OK**.

**Filtering Your View**

By default, when you select a project database, project, or folder, the Version Manager web client displays all of its associated versioned files in the Content pane. The file filter allows you to customize the Content pane so that only the versioned files that match your filter criteria appear. You can filter your view to display only versioned files that:

- Are locked by specific users or by any user
- Match a wildcard filename pattern
- Match a specified promotion group
- Match a specified version label

**NOTE** The appearance of the Show Properties dialog box varies depending on the type of item you selected.
Chapter 3 Navigating the Interface

- Differ or match in terms of revision number, modification time, or revision contents between:
  - Two version labels
  - Two promotion groups
  - A version label and a promotion group

Performing actions on a filtered project

If you perform an action (such as a check out) on a project by selecting it in the Project pane, Version Manager performs the action on all files in the project, including any files not displayed by the current filter (Note, files in subprojects within the selected project are ignored). To limit an action to only the versioned files displayed by the current filter, select the versioned files in the Content pane and then select the action.

NOTE A filtered view remains in effect until you select a different one. To avoid confusion, you may want to clear a filtered view by returning to the All Files view before going on to other work.

Viewing Files Recursively

By default, the Content pane displays only the versioned files located at the root of the item (project database, project, or subproject) you have selected in the Project pane. Unless you select the recursive view, projects, subprojects, and the files contained within nested projects and subprojects are not displayed.

To switch between recursive and non-recursive views:

1. In the Project pane, select the project database or project that you want to view.
2. Click the Recursive/Non-recursive button. The appearance of the button toggles to indicate which filter mode is in effect:
   - Recursive: The Content pane displays all projects, subprojects, and versioned files contained within the item selected in the Project pane.
   - Non-recursive: The Content pane displays only the versioned files contained at the root of the item selected in the Project pane.

Filtering by Locker

Use this filter to find versioned files locked by specified users or by any user.
To set a Locked By filter:

1. From the Filter list on the Status pane, select **Locked By**. The Locked By Filter dialog box appears.

```
Locked By Filter

Locked by:
- Users: [Input Field]
- Any user

OK  Cancel  Help
```

2. Do one of the following:
   - To display versioned files locked by specific users, select the **Users** option and enter one or more user IDs. Separate multiple user IDs with the delimiter character. The default delimiter is a semicolon (;). For information on setting the delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on page 55.
   - To display all locked versioned files regardless of who has them locked, select the **Any user** option.

3. Click **OK**.

**Filtering by Wildcard Filename**

Use this filter to find versioned files that match specified wildcard name patterns.
To set a wildcard filter:

1. From the Filter list on the Status pane, select **Wild Card**. The Wild Card Filename Filter dialog box appears.

   **Wild Card Filename Filter**

   Filename pattern: [ ]

   - Ignore case

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Matches zero or more characters</td>
</tr>
<tr>
<td>?</td>
<td>Matches one character</td>
</tr>
<tr>
<td>[a-z]</td>
<td>Matches a range of characters</td>
</tr>
<tr>
<td>[^a-d]</td>
<td>Matches inverse of pattern</td>
</tr>
</tbody>
</table>

   ![Wild Card Filename Filter](image)

2. Enter filter criteria into the **Filename pattern** field.

   **Use this wild card...**  **To search for filenames that match...**

   *
   Zero or more characters.
   For example, if you want to search for all versioned files with a DLL extension, you would enter *.DLL.

   ?
   One character.
   For example, if you want to search for versioned files that had a pattern in the filename, such as TEST01.DLL, TEST02.DLL, ... TESTXX.DLL, you would enter TEST?? .DLL.

   [ - ]
   A range of characters.
   For example, if you want to search for all versioned files that start with A, B, C, or D, you would enter [A-D] *.

   ^
   A negative character set matching any character not enclosed (for example, [^A-D] * for all file names that do not start with A, B, C, or D).

3. Click **OK**.

**Filtering by Version Label**

Use this filter to find versioned files that include specified version labels.
To set a version label filter:

1. From the Filter list on the Status pane, select **Advanced Filter**. The Advanced Filter dialog box appears.

2. Enter the name of the version labels that you want to filter by in the **Version label(s)** field or browse to select them. Separate multiple version labels with the delimiter character. The default delimiter is a semicolon (;). For information on setting the delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on page 55.

3. Select one of the following options to show versioned files that contain the specified version labels in:
   - Any revision: **Version label**.
   - The tip revision: **Version label assigned to the tip revision**.
   - Any revision except for the tip revision: **Version label not assigned to tip revision**.

4. To inverse the logic of the filter, select the **Show files not matched by this filter** check box.

**NOTE** Version labels are case sensitive. Make sure you use the correct case.
5 Click OK.

### Filtering by Promotion Group

Use this filter to find files that include specified promotion groups.

**To set a promotion group filter:**

1. From the **Filter** list on the Status pane, select **Advanced Filter**. The Advanced Filter dialog box appears.

2. Select the **Promotion Group** option from the **Filter by** list.

3. Enter the names of the promotion groups that you want to filter by in the **Promotion group(s)** field or browse to select them. Separate multiple promotion groups with the delimiter character. The default delimiter is a semicolon (;). For information on setting the delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on page 55.

4. If the specified promotion group is not found, the filter can search for the next highest promotion group, continuing up the promotion model hierarchy until a match is found or the highest level of the promotion model is reached. To enable this feature, select the **Climb the promotion model hierarchy** check box.
5 Select one of the following options to show versioned files that contain the specified promotion groups in:

- Any revision: **Promotion group**.
- The tip revision: **Promotion group assigned to the tip revision**.
- Any revision except for the tip revision: **Promotion group not assigned to tip revision**.

6 To inverse the logic of the filter, select the **Show files not matched by this filter** check box.

7 Click **OK**.

**Filtering by Comparing Two Version Labels**

Use this filter to find versioned files with revisions that differ or match between two specified version labels.

**To set a compare filter using two version labels:**

1 From the **Filter** list on the Status pane, select **Advanced Filter**. The Advanced Filter dialog box appears.
2. Select the **Two Version Labels** option from the **Filter by** list.

3. Enter the name of a version label that you want to filter by in the **First version label** field or browse to select one.  

   **NOTE** Version labels are case sensitive. Make sure you use the correct case.

4. Enter the name of a version label that you want to filter by in the **Second version label** field or browse to select one.

5. Specify whether the files must contain:
   - **Both labels**
- At least one of the labels

6 Select one of the following options to specify how the revisions are compared:
  - Revision number.
  - Modification time.
  - Modification time OR Revision contents: First compares the modification time of the revisions. If the modification time does not differ, then compares the revision contents. This option takes longer if many revisions have the same modification time.
  - Revision contents: Compares the contents of the revisions. This option takes the most time.

7 Specify whether to show files where:
  - The revisions are the same
  - The revisions are different

8 To inverse the logic of the filter, select the Show files not matched by this filter check box.

9 Click OK.

Filtering by Comparing Two Promotion Groups

Use this filter to find versioned files with revisions that differ or match between two specified promotion groups.

To set a compare filter using two promotion groups:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter dialog box appears.
Chapter 3 Navigating the Interface

2. Select the **Two Promotion Groups** option from the **Filter by** list.

3. Enter the name of a promotion group that you want to filter by in the **First promotion group** field or browse to select one.

4. Enter the name of a promotion group that you want to filter by in the **Second promotion group** field or browse to select one.

5. Specify whether the files must contain:
   - **Both groups**
   - **At least one of the groups**

6. Select one of the following options to specify how the revisions are compared:
   - **Revision number.**
- **Modification time.**
- **Modification time OR Revision contents:** First compares the modification time of the revisions. If the modification time does not differ, then compares the revision contents. This option takes longer if many revisions have the same modification time.
- **Revision contents:** Compares the contents of the revisions. This option takes the most time.

7 Specify whether to show files where:
- The revisions are the same
- The revisions are different

8 To inverse the logic of the filter, select the **Show files not matched by this filter** check box.

9 Click **OK**.

**Filtering by Comparing a Version Label and a Promotion Group**

Use this filter to find versioned files with revisions that differ or match between a specified version label and a specified promotion group.

**To set a compare filter using a version label and a promotion group:**

1 From the **Filter** list on the Status pane, select **Advanced Filter**. The Advanced Filter dialog box appears.
2 Select the **One Label and One Promotion Group** option from the **Filter by** list.

3 Enter the name of the version label that you want to filter by in the **Version label** field or browse to select one.

   **NOTE** Version labels are case sensitive. Make sure you use the correct case.

4 Enter the name of the promotion group that you want to filter by in the **Promotion group** field or browse to select one.
5 Specify whether the files must contain:
- Both the label and the group
- The label and/or the group

6 If the specified promotion group is not found, the filter can search for the next highest promotion group, continuing up the promotion model hierarchy until a match is found or the highest level of the promotion model is reached. To enable this feature, select the Climb the promotion model hierarchy check box.

7 Select one of the following options to specify how the revisions are compared:
- Revision number.
- Modification time.
- Modification time OR Revision contents: First compares the modification time of the revisions. If the modification time does not differ, then compares the revision contents. This option takes longer if many revisions have the same modification time.
- Revision contents: Compares the contents of the revisions. This option takes the most time.

8 Specify whether to show files where:
- The revisions are the same
- The revisions are different

9 To inverse the logic of the filter, select the Show files not matched by this filter check box.

10 Click OK.

**Viewing All Versioned Files (No Filter)**

To clear a filtered view and display all versioned files, select All Files from the Filter list on the Status pane.
Chapter 4

Customizing Your Environment

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Version Manager Web Client Options</td>
<td>54</td>
</tr>
<tr>
<td>Setting Workspace Properties</td>
<td>62</td>
</tr>
</tbody>
</table>
Setting Version Manager Web Client Options

You can specify how many items per page the Serena PVCS Version Manager web client displays, how it handles check in/check out/get, whether to include subprojects, and how results dialogs are handled. These options are saved per user ID, allowing them to be retained when you start another Version Manager web client session.

NOTE The options you set in the Version Manager web client do not affect any Version Manager desktop client options you have set.

Default Version Manager Web Client Options

Unless you change the defaults, the Version Manager web client:

- Displays up to 50 items per page.
- Leaves read-only workfiles in the workfile location after a check in.
- Copies a read-only revision when you perform a get.
- Prompts you if a workfile already exists during check out.
- Does not include subprojects in project operations.
- Does not automatically dismiss the Results dialog box after a successful action.
- Uses semicolons (;) to separate multiple entries in dialog box fields.
- Gets or checks out revisions whether or not they are newer than the existing workfiles.
You can change these defaults in the Options dialog box (Edit | Options | General tab).

Setting Number of Items per Page

You can set the maximum number of files that appear on a Version Manager web client page at a time. If the number of files exceeds this limit, multiple pages are used to display the files. From the content pane, you can click the page number or click Previous or Next to access these pages.

To set the number of items per page:

1. On the Edit menu tab, click the Options button. The Options dialog box appears with the General tab active.
2. Enter the maximum number of files to display in the Number of items per page field. The default is 50.
3. Click OK.

Specifying a Delimiter for Items Entered in Fields

By default, semicolons (;) are used to separate multiple entries in dialog box fields. The delimiter character is used in all fields that accept multiple entries.
You need to change the delimiter character if you work with items that use it in their names. You can set the delimiter to be a comma (,), colon (:), or semicolon (;).

**To specify a delimiter character:**

1. On the Edit menu tab, click the **Options** button. The Options dialog box appears with the General tab active.

2. From the **Delimiter** list, select one of the following:
   - Comma
   - Colon
   - Semicolon (default)

3. Click **OK**.

**Defining Check In/Check Out Options**

If you find that you usually change the default options when you perform check in/check out/get operations, the Version Manager web client enables you to change these default settings to fit your working style.

**To change check in/checkout/get options:**

1. On the Edit menu tab, click the **Options** button. The Options dialog box appears with the General tab active.

2. Change the defaults as necessary:
   - **Get read-only revision**: To make workfiles writable when you perform a get, clear this check box.
   - **After checkin**: To determine what to do with the workfile after checkin, select one of the following from the drop-down menu:
     - **Keep read only workfile** (This is the default setting.)
     - **Delete writable workfile**
     - **Keep writable workfile**
   - **If Workfile Exists**: To determine what to do when a workfile already exists, select an option from the drop-down menu:
     - **Prompt**: Asks you what to do. (This is the default setting.)
     - **Overwrite**: Adds the workfile even if a duplicate workfile exists.
     - **Don’t Overwrite**: Does not add the workfile.
   - **Get only if revision is newer than workfile**: To get or check out a revision only if it is newer than the workfile, select this check box. This saves time by not getting revisions that have not changed.

3. Click **OK**.

**IMPORTANT!** Choose a delimiter character that is *not* present in the items you wish to enter into dialog box fields.
Defining Revision Lookup Behavior

Since Get operations ignore promotion groups unless you specify one in the Promotion Group field, a Get operation and a Checkout operation may not return the same revision. By defining the revision lookup behavior, you can cause a Checkout operation to behave like a Get. These settings are relevant only when a promotion model is in effect.

To configure the default revision lookup behavior for Get and Checkout operations:

1. On the Edit menu tab, click the Options button. The Options dialog box appears with the General tab active.

2. Select one of the following from the Lookup options for Get and Checkout Dialog list:
   - **Classic lookup:**
     For Get operations, if the user does not specify a revision, version label, or promotion group to act on, the default revision, if one is defined in the configuration file, will be retrieved. Else the Tip revision on the Trunk will be retrieved.
     For Checkout operations, the revision defined by the lowest-level promotion group will be acted on. If such a revision is not found, the operation will climb the promotion model.
   - **Lookup revision based on Revision:** The revision specified by the user will be acted on. If the user selects [Default Revision] in the Revision field, the revision specified by the workspace settings or configuration file will be acted on; if no default value is found, the Tip of the Trunk will be acted on.
   - **Lookup revision based on Promotion group:**
     For Get operations, the revision assigned to the promotion group in the Promotion Group field of the Get dialog will be retrieved. If such a revision is not found, the operation will climb the promotion model and act on the revision assigned to the lowest currently assigned group in the promotion model.
     For Checkout operations, the revision assigned to the promotion group specified in the Lowest-level promotion group field will be acted on.
     If the user selects [Default Promotion Group] in the Lowest-level promotion group field, the revision currently assigned to the promotion group specified by the workspace settings or configuration file will be acted on. If a default is not defined, the lowest-level group in the promotion model will be used. If there are multiple lowest-level groups, the user will be prompted to select one. If such a revision is not found, the operation will climb the promotion model and act on the revision assigned to the lowest currently assigned group in the promotion model.

3. Click OK.

Including Subprojects in Project Operations

When you perform actions on project databases and projects, the Version Manager web client only performs actions on the versioned items contained directly at the project database or project level. The Version Manager web client does not include versioned files in subprojects as part of its default operation.
Chapter 4  Customizing Your Environment

If you usually include subprojects when you perform actions on project databases and projects, you can change the default to include subprojects.

To include subprojects:
1. On the Edit menu tab, click the Options button. The Options dialog box appears with the General tab active.
2. Select the Include subproject in project operations box.
3. Click OK.

Dismissing Results Dialog Boxes after Successful Action

By default, the Results dialog box appears after an action is complete to show if the action was successful, or if any errors or warnings occurred. You must click the Close button to dismiss the Results dialog box. If you want the Results dialog box to automatically close after an action is successful, you can change the default behavior.

To automatically dismiss Results dialog box:
1. On the Edit menu tab, click the Options button. The Options dialog box appears with the General tab active.
2. Select the Automatically dismiss results dialogs when action is successful box.
3. Click OK.

If errors occur, the Results dialog box will not automatically close.

Setting Your Default Editor

Setting your default editor specifies which editor Version Manager launches when you click a versioned file in the Contents pane or a revision in the Revisions pane.

Windows
On Windows, Version Manager opens the file in either the editor defined by the Windows file type associations or a specific editor you have selected. By default, Version Manager uses the Windows file type associations. We recommend that you use the Windows file type associations.

NOTE
If the wrong application is launched when you double-click a file, correct the Windows file type associations using Windows Explorer (Tools | Folder Options | File Types tab).

UNIX
On UNIX, you must define the location of an editor so that you can launch files for editing or viewing from within Version Manager. The Use default Windows associations option is not available to UNIX users.

To set your default editor:
1. On the Edit menu tab, click the Options button. The Options dialog box appears with the General tab active.
2. Select the Applications tab.
3 (Windows only) If you want to use the Windows file type associations to launch an editor, select the **Use default Windows associations** check box.

4 In the **Editor Location** field, enter the location of the editor program executable, or click the Browse button to select it.

- (UNIX only) If you specify a non-GUI editor that launches its own window (such as vi), you will need to launch the editor in an xterm or other type of window. For example, in the Editor Location field, you would enter:

```
xterm editor path
```

where *editor path* is the location of your editor.

- (Windows only) If you specify an editor **and** select the **Use default Windows associations** check box, the editor you specified will be used only if Windows cannot find an association.

5 Click OK.

### Specifying a Difference or Merge Tool

By default, Version Manager uses the Serena PVCS merge tool when differencing or merging. However, you can configure Version Manager to use third-party difference and merge tools.

Administrators have the option to define the default tool for a user the `vm\common\inet\props\UserID\useropt.ini` file instead of selecting it through the Options | Advanced tab.

**CAUTION!** The Administrator must be adept at making changes to the `useropt.ini` file as any errors could severely affect the Version Manager I-Net client for the user whose `useropt.ini` file is being modified.

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Sample islv.ini Configuration Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serena PVCS merge tool</td>
<td><code>pvcs.diff.tool.cmd.win32=pvcsmerge.exe</code></td>
</tr>
<tr>
<td>WinMerge</td>
<td><code>pvcs.diff.tool.cmd.win32=D:\VM\Setup Files\WinMerge-2.8.0.exe\winmerge.exe /dl __AncestorLabel__ /dr __Derivative1Label__ __AncestorFile__ __Derivative1File__</code></td>
</tr>
<tr>
<td>TkDiff</td>
<td><code>pvcs.diff.tool.cmd.win32=c:\progra~1/tkdiff/tkdiff.exe __AncestorFile__ __Derivative1File__ -L __AncestorLabel__ -L __Derivative1Label__</code></td>
</tr>
</tbody>
</table>

For the list of arguments, see "Argument" on page 61 in this user guide.

**To specify a difference or merge tool:**

1 On the Edit menu tab, click the **Options** button. The Options dialog box appears with the General tab active.

2 Select the Advanced tab.
3 In the **Diff command** field and in the **Merge command** field, enter the location of the third party executable, or click the Browse button to select it.

The argument selection button ( ) facilitates two types of selections:

- **Predefined Diff / Merge tools**

  Above the separator bar are names of predefined Diff/Merge tools like WinMerge, TkDiff and Version Manager PVCS Diff Tool. Select these options to replace the value of the Diff/Merge command with a set of arguments that work with these tools.

**NOTE** Except for the PVCS Diff Tool, the arguments are provided as an example only and are not guaranteed to work on all versions of those tools.

**NOTE** An administrator can add, modify or delete the predefined Diff/Merge tools by changing the `diffmerge.properties` files. This file is stored in the directory `vm/common/pvcsprop/pvcs/vm`.

- **Arguments**

  If you want to manually construct a Diff/Merge command, you can select values (arguments) from below the separator bar. This will provide access to values in the Diff/Merge dialog as selected at run time.
The following table is a list of difference and merge arguments that can be applied. The result column lists sample result values for each parameter:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Usage</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>AncestorFile</em></td>
<td>Use this parameter to select the base file (the file from which the other files were derived).</td>
<td>C:\DOCUME<del>1\Clyde</del>1\LOCALS~1\Temp\unuz781.tmp</td>
</tr>
<tr>
<td><em>AncestorLabel</em></td>
<td>Use this parameter to pass a label that describes the ancestor file.</td>
<td>Base: /Project1/islvtk.ini 1.1</td>
</tr>
<tr>
<td><em>Derivative1</em>/ <em>Derivative2</em></td>
<td>Use these parameters to access the files associated with the Branch1 / Branch2 selections.</td>
<td>C:\DOCUME<del>1\Clyde</del>1\LOCALS~1\Temp\v6dvuw0.tmp</td>
</tr>
<tr>
<td><em>Derivative1Label</em>/ <em>Derivative2Label</em></td>
<td>Use these parameters to pass labels that describe the Branch 1 / Branch 2 files (to be used as captions).</td>
<td>Branch 1: /Project1/islvtk.ini 1.0</td>
</tr>
<tr>
<td><em>IsMerge</em></td>
<td>This parameter will be replaced by true if the command is executed as part of a Merge operation, and false if it is executed as part of a Diff operation.</td>
<td></td>
</tr>
<tr>
<td><em>TargetFile</em></td>
<td>Use this parameter to pass the output file path specified by the user in the Show Merge dialog.</td>
<td>C:\DOCUME<del>1\Clyde</del>1\LOCALS~1\Temp</td>
</tr>
</tbody>
</table>

4 Select the Three-way merge supported checkbox if the selected third party tool supports three way merging.

5 Click Ok.

For more information on using the diff/merge tool, see "Comparing Files" on page 69 and "Merging Files" on page 75 in this manual.

**Passing Options Based on Ignore White Space**

Version Manager has an Ignore white space checkbox on the Show Differences dialog. It is possible to create an optional argument for the Diff tool based on the state of this checkbox.

This can be done using the parameter __IfIgnoreWhitespace__.

The syntax for this parameter is:

__IfIgnoreWhitespace__DiffArgumentIfBoxIsSelected|DiffArgumentIfBoxIsNotSelected

For example, if your Diff tool expects the argument -b to ignore white space, you would include:

__IfIgnoreWhitespace__-b||
in your list of arguments.

NOTE In the above example when a user selects **Ignore white space**, the option -b will get passed to the specified Diff command. When it is not selected, no argument is passed.

If your Diff tool enables white space handling using arguments like `--ignore-white-space=true` and `--ignore-white-space=false`, you can use:

```
__IfIgnoreWhitespace__-ignore-white-space=true|-ignore-white-space=false|
```

### Setting Workspace Properties

A workspace is a collection of work settings defined for a project database. You can define multiple workspaces so you can easily switch work settings to match your environment. Each user has one active workspace at a time. The work settings include:

- The workfile locations defined for the project database and its contents.
- The default version used when you do not specify a revision number or version label.
- The base version and branch version used for automatic branching, if enabled.
- The default promotion group used if a promotion model is in effect.

**Public or private workspaces**

Workspaces can be public or private. A public workspace is typically created by an administrator when a project database is created. Any changes made to a public workspace affect everyone using that workspace. A private workspace is typically created by a user to customize the work settings for the user's personal work environment. Any changes made to a private workspace affect only the user who created it.

**Root workspaces**

The Root workspace is the default public workspace. It is automatically created every time your administrator creates a project database. You cannot delete or rename the Root workspace. You can only change the settings of the Root workspace if your administrator has assigned you those privileges.

If you do not create or set any other workspaces, the Root workspace is set as the default workspace.

### Setting Your Workspace

When start using the Version Manager web client, specify which workspace you want to use. You can also specify whether to make the workspace the default when you start another web or desktop client session.
To set your workspace:

1. On the File menu tab, click the Set Workspace button. The Set Workspace dialog box appears.

2. Select the workspace from the Workspaces list that you want to use with the project database.

3. To associate this workspace with the project database for subsequent Version Manager web or desktop client sessions, select the Make this your default workspace box. Otherwise, this workspace is only active during your current Version Manager web client session.

4. Click OK.

Setting Your Workfile Location

The workfile location is the location where you check in and check out workfiles. It is set when the project is first created, and is stored in the workspace assigned to the project database.

You can change the workfile location for any project or versioned file in the project database. Changing the workfile location while in a public workspace changes the workfile location for all users accessing the project using that public workspace. If the workspace is private, then changing the workfile location will not affect other users.

To set a workfile location:

1. Select the project database, project, or versioned file.

2. On the File menu tab, click the Set Workfile Location button or click the Workfile Location link in the content pane.
Chapter 4 Customizing Your Environment

The Set Workfile Location dialog box appears.

3 Enter or browse to the new workfile location in the Workfile Location field.

4 Click OK.

Defining the Default Revision

By default, the latest revision (tip) of the versioned file is used during get, check out, and lock operations. However, you can define the default revision to be a specific version label instead.

To define the default revision:

1 Set the workspace you want to edit.

2 On the File menu tab, click the Properties button. The Properties dialog box appears.

3 Enter a version label in the Default Version field and click OK.

Enabling Automatic Branching

Automatic branching lets you create a branch automatically from a trunk revision. Then, by default, you operate on the tip revision of that branch whenever you perform an action.

To set up automatic branching, you assign two fixed version labels to the revision from which you want to branch. One version label marks where the branch starts, and the
other marks the tip of the branch. You then specify these version labels in the active workspace.

**NOTE** Before you set up automatic branching, check with your administrator to make sure you have the necessary security privileges. Also make sure that you coordinate version label names with the rest of your project team.

**To enable automatic branching:**

1. Select the versioned file(s) for which you want to enable automatic branching.

2. On the Actions menu tab, click the **Label** button. The Version Label dialog box appears.

3. Assign a fixed version label to the revision:
   a. Click the **Assign** option.
   b. Enter the name of the version label in the **Assign Version Label** field. For example, Rel1.0 Base.
   c. Enter the revision number in the **To revision** field.
   d. Click **OK**.

   This version label becomes the Base Version.

4. Repeat steps 2 and 3 to assign another fixed version label to the revision. For example, Rel1.5 Branch.

   This version label becomes the Branch Version.

5. Select the project or project database that contains the versioned file(s).

6. On the File menu tab, click the **Properties** button. The Properties dialog box appears.

7. On the Workspace Settings tab:
   a. Enter the version label for the branch version in the **Default Version** field. This is the label you assigned in Step 4 (for example, Rel1.5 Branch).
   b. Enter the version label for the branch version in the **Branch Version** field. This is the label you assigned in Step 4 (for example, Rel1.5 Branch).
c Enter the version label for the base version in the **Base Version** field. This is the label you assigned in Step 3 (for example, Rel1.0 Base).

8 Click **OK**.

The Version Manager web client creates the branch when you check out the revision and then check it back in. The branch version label floats with the tip of the branch.

**Defining the Default Promotion Group**

You can only check out revisions to the lowest-level promotion groups reserved for development. Regardless of what promotion level a revision has reached, when you check out and lock a revision, you must assign the revision to the lowest-level promotion group to continue development.

If you have multiple promotion groups for development, the Version Manager web client prompts you to select which promotion group you want to assign to the revision you are checking out or locking. In the following example, you would choose between Dev and Bug_fix.

If you find that you are checking out revisions to the same lowest-level promotion group each time, you can specify which lowest-level promotion group to use by default. You specify the default lowest-level promotion group in the workspace.
To define the default promotion group:

1. Set the workspace you want to edit. See "Setting Your Workspace" on page 62.
2. On the File menu tab, click the **Properties** button. The Properties dialog box appears.
3. Select the lowest-level promotion group from the **Default Promotion Group** list.
4. Click **OK**.
Chapter 5
Comparing Files

About Comparing Files 70
Viewing Differences 70
Interpreting Difference Results 72
About Comparing Files

Side-by-side comparisons
Serena PVCS Version Manager allows you to select two text files and compare them side-by-side to see the additions, deletions, and changes made to the files. You cannot compare binary files.

Compare revisions and workfiles
The Show Differences option (Actions | Difference) allows you to compare:
- A revision and a workfile
- Revisions in a single versioned file
- Revisions in two different versioned files
- Two workfiles

View only
The Show Differences option provides a quick comparison of two files. You cannot print or save the comparison.

Viewing Differences

To view the differences between files:

1. Select the versioned file(s) or revision(s) that you want to compare. You can select any text files.

   NOTE To compare revisions located in different projects (but within the same project database), select the project database. You cannot compare revisions located in different project databases.
2 Select Action tab | Difference. The Show Differences dialog box appears.

![Show Differences dialog box]

NOTE The appearance of the Show Differences dialog box varies depending on the type of comparison you select.

3 Select the type of comparison that you want to perform in the **Compare** drop-down menu.

<table>
<thead>
<tr>
<th>To compare...</th>
<th>You must specify...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A revision and a workfile</td>
<td>A versioned file and revision number, and a workfile</td>
</tr>
<tr>
<td>Revisions in a single versioned file</td>
<td>A versioned file and revision number, and a second revision number</td>
</tr>
<tr>
<td>Revisions in different versioned files</td>
<td>Two versioned files and two revision numbers</td>
</tr>
<tr>
<td>Workfiles</td>
<td>Two workfiles</td>
</tr>
</tbody>
</table>

4 To change the revision (or file, if comparing workfiles) selected as the first file, edit the field or click the Browse button.

5 To change the revision (or file, if comparing workfiles) selected as the second file, edit the field or click the Browse button.

6 Select the **Ignore white space** check box if you want to ignore trailing, intervening, and leading white spaces, tabs, and form feeds.
7 Click **OK**. The Merant Merge Tool is launched with the two files side-by-side in separate panes.

![Merant Merge Tool](image)

8 To view the differences, scroll through the files and compare the colored text blocks. Windows users can also click the Next Difference button ( ) to jump directly to the next difference.

## Interpreting Difference Results

**Types of differences**

- File 1 is used as the base file. File 2 is compared to File 1. Differences between the files are categorized into additions, deletions, and changes.

  - **Additions** are the lines of text that were added to File 2. These lines of text are not in File 1.
  - **Deletions** are the lines of text that were deleted from File 2. These lines of text are in File 1.
  - **Changes** are the lines of text that were modified in one of the files.

**Placeholders**

- Placeholders are the blocks of colors used to identify the types of differences between the files. Each difference type (additions, deletions, and changes) has two placeholders (or colors) assigned to it: one for selected one for unselected.

![Placeholders](image)

**Windows users**

- Windows users have the option of changing the colors of the placeholders. To change the colors, from the Merant Merge Tool, click the Configuration button ( ) and select the Colors tab.
Windows users also have the option of displaying a color legend to help identify what each placeholder stands for. To display the color legend, from the Merant Merge Tool, click the Color Tips button. The Color Tips dialog appears.

![Colour Tips](image)

**Difference Examples**

The following examples show how the differences between two files can vary depending on the file you select as File 1 (the base file).

**Example 1** This example shows two revisions from the same versioned file. Version 1.0 was selected as File 1 (base file) and version 1.2 was selected as File 2.

<table>
<thead>
<tr>
<th>File 1 (version 1.0)</th>
<th>File 2 (version 1.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes</td>
<td>Additions</td>
</tr>
</tbody>
</table>

Lines 4, 5, and 6 have been changed and are highlighted as one block of differences. These differences are identified by change placeholders. Line 6.5 was added to File 2 and is highlighted as another block of differences. These differences are identified by addition placeholders.
Example 2 Using the same files above but reversing the order of the files, you get the following results.

File 1 (version 1.2)  File 2 (version 1.0)

Changes
Deletions

Lines 4, 5, and 6 are still highlighted as differences and identified by change placeholders. However, the added line, line 6.5, is now in File 1 (the base file) but no longer in File 2. This difference is identified by deletion placeholders.
About Merging

What is merging? Merging is the process of comparing the differences between two (or more) text files, or revisions of text files with a common base file, accepting or rejecting the differences between them, and combining the changes into a new text file.

You cannot compare or merge binary files.

Why merge files? Merging is useful for parallel development. It enables you to combine the work performed on a branch of development and integrate it back into the main line of development.

Types of merges Serena PVCS Version Manager allows you to perform a variety of merges. You can merge:
- A revision with a workfile
- Revisions within a single versioned file
- Revisions in different versioned files
- Workfiles

Windows users Version Manager for Windows can perform N-way (unlimited) merges. Although you can select only three files (one base and two branch files) from within Version Manager, you can perform an N-way merge once the Serena Merge Tool is launched. For information on how to perform N-way merges, please see the Serena Merge Tool online help.

UNIX users Version Manager for UNIX can perform two-way (a base file and a branch file) merges. N-way merges are not supported on UNIX.

Merging Terms and Definitions

The following table is a list of basic merge terms and definitions:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base or Ancestor</td>
<td>The base file from which other files are derived.</td>
</tr>
<tr>
<td>Branch or Derivative</td>
<td>The result obtained by making changes in the base file.</td>
</tr>
<tr>
<td>Output or Target</td>
<td>The final merged file.</td>
</tr>
<tr>
<td>Addition</td>
<td>A line of text added to a branch file. This line of text is not in the base file.</td>
</tr>
<tr>
<td>Deletion</td>
<td>A line of text deleted from a branch file. This line of text is in the base file.</td>
</tr>
<tr>
<td>Change</td>
<td>A line of text that was modified in one of the branch files. The content of this line of text differs between the branch file and the base file.</td>
</tr>
<tr>
<td>Conflict (Windows only)</td>
<td>A line of text that was modified in multiple branch files. The content of this line of text differs between the branch files and the base file.</td>
</tr>
</tbody>
</table>

**NOTE** In UNIX, *changes* are treated as *conflicts* and must be resolved by the user.
The Merge Process

The merge process consists of:

- Locking the tip of the branch or trunk where you want to check in the output (target) file
- Selecting a base file (ancestor) as a reference point
- Selecting a revision branch file (derivative)
- Entering an output (target) file name
- Resolving conflicts between the base and branch files by either accepting or rejecting the changes made
- Saving the changes made to the output (target) file
- Checking in the output file

Selecting a Base File

A base file is the file that you want to use as your point of reference. It is usually the branch point—the revision from which a branch begins (typically off the main trunk of development).

If you are merging revisions that are located in different branches or versioned files, the base file you select should be the revision or file that is the latest file to be created which is a common ancestor to all of the revisions that you want to merge.

IMPORTANT! UNIX Only:

If you are merging or comparing revisions on a branch to revisions on a trunk on UNIX, you should set the base file to the latest revision on the trunk, then select the latest revision on the branch as the branch file.

The closer the content of the base file is to that of the files you are merging, the fewer conflicts you will have to resolve. For example, if you want to merge the changes from revision 1.2.1.2 with revision 1.4.1.1, you would use revision 1.2 as the base file. You could use revision 1.1 or 1.0 as the base file, but we recommend using the revision that is closest to the files you are merging.

Merging Files in Windows or UNIX

To merge files:

1. Lock the tip of the branch or trunk where you want to add the results of the merge.
2. Select the versioned file(s) or revision(s) that you want to merge.

When selecting files to merge, consider the following:

- The order in which you select the files determines which file will be the base and which the branch file(s). The first file that you select is the base file; the second and (on Windows only) third files that you select are the branch files.
The items you select (project, versioned file, or revision) affect the initial options that appear.

**NOTE** You can change the options when the Show Merge dialog box appears.

- (UNIX only) To merge a trunk and branch revision, you must set the base file to the tip revision on the trunk, and the branch file to the tip revision on the branch.
- To merge revisions located in different projects (but within the same project database), select the project database. You cannot merge revisions located in different project databases.
- (Windows only) If you want to merge just two files, enter the same file in the **Base** and **Branch 1** fields; use the **Branch 2** field for the second file.

3 Select Actions | Merge. The Show Merge dialog box appears.

![Show Merge dialog box](image)

**NOTE** The appearance of the Show Merge dialog box varies depending on the type of merge you select.

4 Select the type of merge that you want to perform from the **Merge** drop-down menu.

<table>
<thead>
<tr>
<th>To merge...</th>
<th>On Windows you must specify...</th>
<th>On UNIX you must specify...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A revision and a workfile</td>
<td>A base file and revision number, a branch revision number, and a branch workfile</td>
<td>A base file and revision number, and a branch workfile</td>
</tr>
<tr>
<td>Revisions in a single versioned file</td>
<td>A base file and revision number, and two branch revision numbers</td>
<td>A base file and revision number, and a branch revision number</td>
</tr>
<tr>
<td>To merge...</td>
<td>On Windows you must specify...</td>
<td>On UNIX you must specify...</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Revisions in different versioned files</td>
<td>A base file and revision number, and two branch files with revision numbers</td>
<td>A base file and revision number, and a branch file and revision number</td>
</tr>
<tr>
<td>Workfiles</td>
<td>A base workfile and two workfiles</td>
<td>A base workfile and a branch workfile</td>
</tr>
</tbody>
</table>

5. To change the revision (or file, if merging workfiles) selected in the **Base** group, click the Browse button.

**NOTE** UNIX Only:

To merge a trunk and branch revision on UNIX, you must set the base file to the tip revision on the trunk.

6. To change the revision (or file, if merging workfiles) selected in the **Branch 1** (Windows) or **Branch** (UNIX) group, click the Browse button.

**NOTE** UNIX Only:

To merge a trunk and branch revision on UNIX, you must set the branch file to the tip revision on the branch.

7. (Windows only) To change the revision (or file, if merging workfiles) in the **Branch 2** group, click the Browse button.

8. Enter the name of the output (target) file in the **Output File** field, or click the Browse button to select an existing workfile.

**NOTE** If you enter an output filename without entering a path, the output file will be created in the BIN directory within your Version Manager installation directory. If the filename already exists in the selected location, the old file will be overwritten.
9 Click OK. On Windows, the base file and branch files appear in the Frames window and the results of the merge appear in the Output File window.

On UNIX, the base file and branch file appear in the Merge Tool window.

10 Resolve the conflicts between the base and branch files. For information on how to resolve the conflicts, see one of the following:

- "Resolving Conflicts Between Files in Windows" on page 84
- "Resolving Conflicts Between Files in UNIX" on page 85

11 To save the results of the merge to an output file, do one of the following:
On Windows, select File | Save Target.
On UNIX, select File | Save As and click OK.

**NOTE** You do not need to re-enter the output path or filename.

12 Open the output file and review it. If you are satisfied with the results of the merge, check the output file into the tip of the branch or trunk you selected in Step 1.

## Interpreting Difference Results in Windows

### Types of differences

The file that you select as the base file is used as the basis of the output file. Branch 1 and branch 2 are compared against the base file. Differences between the base and branch files are categorized as additions, deletions, and changes.

- **Additions** are the lines of text that were added to a branch file. These lines of text are not in the base file.
- **Deletions** are the lines of text that were deleted from a branch file. These lines of text are in the base file.
- **Changes** are the lines of text that were modified in one of the branch files. The content of these lines of text differ between the branch file and the base file.
- **Conflicts** are the lines of text that were modified in multiple branch files. The content of these lines of text differ between the branch files and the base file.

### Placeholders

Placeholders are the blocks of colors used to identify the types of differences between the files. Each difference type (additions, deletions, and changes) has two placeholders (or colors) assigned to it: one for selected and one for unselected.
Displaying a color legend

You can display a color legend to help identify what each placeholder stands for. To display the color legend, from the Serena Merge Tool, click the Color Tips button ( ). The Color Tips dialog box appears.

![Color Tips dialog box](image)

**Changing Placeholder Colors**

**To change the colors of the placeholders:**

1. Click the Configuration button ( ).
2. Select the Colors tab.
3. Click on the background or text color that you want to change.
4. Select a new color from the color palette and click **OK**.

**Conflicts**

Conflicts occur when the content of a line in multiple branch files differ from the content of the line in the base file.
By default, conflicts appear as blocks of text that are shaded with slashes (/ / /). When you resolve a conflict, the slashes remain on the selected block of text while the unselected conflict blocks (which are now resolved) are shaded with Xs (XXX).

### Changing Conflict Shading

To change the shading of the conflicts:

1. Click the Configuration button ( ).
2. Select the Colors tab.
3. Choose a shading pattern from the appropriate **Conflicting lines** drop-down menu.

### Interpreting Difference Results in UNIX

#### Types of differences

The file that you select as the base file is used as the basis of the output file. The branch file is compared against the base file. Differences between the base and branch files are categorized as additions, deletions, and changes.

- **Additions** are the lines of text that were added to the branch file. These lines of text are not in the base file.
- **Deletions** are the lines of text that were deleted from the branch file. These lines of text are in the base file.
- **Changes** are the lines of text that were modified in the branch file. The content of these lines of text differ between the branch file and the base file.

**NOTE** In UNIX, *changes* are treated as *conflicts* and must be resolved by the user.
Chapter 6  Merging Files

Placeholders

Placeholders are the blocks of colors used to identify the types of differences between the files. Each difference type (additions, deletions, and changes) has two placeholders (or colors) assigned to it: one for selected and one for unselected.

Displaying a color legend

You can display a color legend to help identify what each placeholder stands for. To display the color legend, from the Serena Merge Tool, select Help | Color Legend.

Changing Placeholder Colors

To change the colors of the placeholders, edit the Mgdiff Legend file with a text editor. This file is located in the /bin/app-defaults directory where you installed Version Manager.

Resolving Conflicts Between Files in Windows

By default, the Serena Merge Tool automatically inserts all of the additions, deletions, and changes into the output (target) file, but not the conflicts. Before you can successfully merge revisions, you must resolve all conflicts.

On Windows, a conflict occurs when a line of text differs between multiple branch files and the base file. The Serena Merge Tool cannot determine which block to select, so you must resolve the conflict by choosing which block of text you want in the output file.

NOTE To resolve conflicts, you must be able to identify the differences between the base and branch files. For information on how to identify the additions, deletions, and changes between base and branch files, see "Interpreting Difference Results in Windows" on page 81.

To resolve conflicts between the base and branch files:

1 From the Frames window in the Serena Merge Tool, click the Next Conflict button ( ) to jump to the next conflict block.
2 Resolve conflicts by right-clicking the block of text that you want to appear in the output (target) file. The conflict block that you select changes color and the shading of the unselected files changes to resolved.

Right-click to select a conflict block

<table>
<thead>
<tr>
<th>Unresolved</th>
<th>Resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textcolor{red}{14 line12}</td>
<td>\textcolor{green}{14 line12}</td>
</tr>
<tr>
<td>\textcolor{red}{15 line12}</td>
<td>\textcolor{green}{15 line12}</td>
</tr>
<tr>
<td>\textcolor{red}{16 line12}</td>
<td>\textcolor{green}{16 line12}</td>
</tr>
<tr>
<td>\textcolor{red}{17 line12}</td>
<td>\textcolor{green}{17 line12}</td>
</tr>
<tr>
<td>\textcolor{red}{18 line12}</td>
<td>\textcolor{green}{18 line12}</td>
</tr>
<tr>
<td>\textcolor{red}{19 line12}</td>
<td>\textcolor{green}{19 line12}</td>
</tr>
</tbody>
</table>

3 Repeat steps 1-2 until all conflicts have been resolved.

4 Check the contents of the output (target) file. Make sure that you have merged the appropriate content into the output file.

5 Select File | Save Target to save the output (target) file.

Resolving Conflicts Between Files in UNIX

By default, the Serena Merge Tool automatically inserts all of the additions and deletions into the output (target), but not the changes. Before you can successfully merge revisions, you must resolve all conflicts (changes).

On UNIX, a conflict occurs when a line of text has been modified in the branch file so that the content of this line of text differs between the branch file and the base file. The Serena Merge Tool cannot determine which block to select, so you must resolve the conflict by choosing which block of text you want in the output file.

\textbf{NOTE} On UNIX, changes are treated as conflicts and must be resolved by the user.

\textbf{NOTE} To resolve conflicts, you must be able to identify the differences between the base and branch file. For information on how to identify the additions, deletions, and changes between base and branch files, see “Interpreting Difference Results in UNIX” on page 83.

To resolve conflicts between the base and branch file:

1 From the Merge Tool window, scroll to a conflict block.

2 Resolve the conflict by clicking the block of text that you want to appear in the output (target) file. The conflict block that you select changes color.

3 Repeat Steps 1-2 until all conflicts have been resolved.
4 Select File | Save As and click **OK** to save the output (target) file. You do not need to reenter the output path or filename.
# Appendix A: Naming Conventions and Restrictions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Naming Conventions and Restrictions</td>
<td>88</td>
</tr>
<tr>
<td>Specific Naming Conventions and Restrictions</td>
<td>89</td>
</tr>
</tbody>
</table>
Appendix A: General Naming Conventions and Restrictions

You can use most alpha, numeric, and special characters when creating or renaming Version Manager entities and paths. However, your operating system also determines the conventions that apply to file and directory names.

Prohibited Characters for Files and Directories

The following characters are prohibited by Version Manager, and most operating systems, when naming files or directories:

- Angle brackets (>) and (<)
- Asterisk (*)
- Colon (:
- Pipe (|)
- Question mark (?)
- Quotation mark ("
- Slashes, forward (/) and backward (\)
- Space ( ) as the first or last character
- Tab

**IMPORTANT!** On Windows systems, files and directories (and thus Version Manager entities and paths) cannot end with a period (.).

Naming Considerations for Cross-Platform Environments

When working in a cross-platform environment, be aware of any incompatibilities between the systems and limit your usage to that which they have in common.

**IMPORTANT!** In a cross-platform environment, you cannot place files into the same directory if they differ only be case. Such usage is possible only in UNIX-only environments.
Specific Naming Conventions and Restrictions

The following table lists naming conventions and restrictions that apply to specific Version Manager entities and paths.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Characters</th>
<th>Length</th>
<th>Restrictions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archives</td>
<td>As listed in &quot;Prohibited Characters for Files and Directories&quot; on page 88, plus cannot use: Ampersand: &amp; Brackets: [ ] Parenthesis: ( ) Plus sign: + Semicolon: ;</td>
<td>254 (full path including the file name)</td>
<td><strong>NOTE</strong> Only the first 10 characters of the archive suffix are significant in distinguishing identically named files in the same project.</td>
</tr>
<tr>
<td>Files and paths</td>
<td>As listed in &quot;Prohibited Characters for Files and Directories&quot; on page 88.</td>
<td>254 (full path including the file name)</td>
<td></td>
</tr>
<tr>
<td>(unless otherwise noted)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>pvcs_bindir</td>
<td>As listed in &quot;Prohibited Characters for Files and Directories&quot; on page 88.</td>
<td>254 (full path including the file name)</td>
<td><strong>NOTE</strong> On UNIX, the name of the vconfig file and the separator character also count against the total length.</td>
</tr>
<tr>
<td>Project databases</td>
<td>Cannot begin or end with a tab or space character. Any character can be used within the name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projects</td>
<td>As listed in &quot;Prohibited Characters for Files and Directories&quot; on page 88, plus cannot be:  - The two-character name of: ..  - The one-character name of: .  - The one-character name of: @</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Restrictions

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Characters</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promotion groups</td>
<td>&amp;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td></td>
<td>( )</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>User, group, and privilege names</td>
<td>*</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>'</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>( )</td>
<td></td>
</tr>
<tr>
<td>Version labels</td>
<td>&amp;</td>
<td>254</td>
</tr>
<tr>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>=</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>( )</td>
<td></td>
</tr>
<tr>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td></td>
<td>?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>/</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** The backslash (\) serves as an escape character. To create or delete a label that includes a backslash, the backslash must be preceded by another backslash (\Label would result in \Label; \\Label would result in \Label).
Index

Numerics

5.3/6.0 folders
   deleting 37
   renaming 37
   reviewing properties of 38
5.3/6.0 projects
   limitations 17
   reviewing properties of 38

A

about
   merging 76
   Version Manager web client 10
   Version Manager web client options 54
   workspaces 62
adding workfiles 10
ancestor file, see base file 61, 76
automatic branching 64

B

base
   file 61, 76
branch
   file 76
branching, setting up automatic 64

c

CAC 22
changing
   passwords 23
   users 24
checking in 10
checking out 10
Common Access Card login 22
comparing files 70
   about 70
   interpreting differences 72
   viewing differences 70
comparing revisions 70
conflict
   changing shading 83
   types 82
conflicts
   resolving
      on UNIX 85
      on Windows 84
connecting to Version Manager web client 20
contacting technical support 8
content pane 29
conventions, typographical 7
copying versioned files 11
creating projects 10

d

default
   editor 58
   default promotion group 66
   default revision 64
   default workspace 62
defining
   default check in options 56
   default check out options 56
   default get options 56
   default promotion group 66
   default revision 64
deleting
   5.3/6.0 folders 37
   projects 37
   versioned files 37
delimiter character for fields 55
derivative file, see branch file 76
difference report 70
difference report, see comparing files 70
difference reports 10
difference tool, specifying 59
differences
   interpreting 72
   viewing 70
discharging Results dialog box 58

E

editor, default 58

f

fields, description 31=file
   base 61, 76
Index

branch 76
output 61, 76
selecting a base 77
files
    comparing 70
    merging 76
filter
    by comparing a version label and promotion group 49
    by comparing two promotion groups 47
    by comparing two version labels 45
    recursive 40
filtering
    by promotion group 44
    by user locks 40
    by version label 42
    by wildcard filename 41
filtering versioned files 39
filters
    locked by 41
    promotion groups 44
    version label 43, 45, 47, 49
    wildcard 42

G
getting revisions 10

H
history reports 10

I
icons, description 31
items
    deleting 37
    moving 36
    renaming 37
    reviewing properties of 38
    selecting 35

L
licenses, freeing 22
locking 10
locks
    filtering by 40
logging into
    project databases 20
    projects 22
logging out of project databases 25
login session, stale 22
login, SSO/CAC 22
lowest-level promotion group 66

M
menu pane 32
merge tool, specifying 59
merges
    about 76
    conflict
        changing shading 83
        types 82
    interpreting results
        on UNIX 83
        on Windows 81
    merging files
        on Windows 77
    merging process 77
    N-way 76
    placeholders
        changing colors in Windows 82
        changing colors on UNIX 84
        on UNIX 84
        on Windows 81
    resolving conflicts
        on UNIX 85
        on Windows 84
    selecting a base file 77
    terms and definitions 76
    types of 76
    merging files 76
    moving versioned files 36

N
number of items per page, setting 55
N-way merges 76

O
online help
    accessing 7
    for the command-line interface 7
    for the desktop client 7
output file 61, 76

P
panes
    content 29
    menu 32
    project 28
    revision 30
    status 34
passwords, changing 23
placeholders
    changing colors in Windows 82
    changing colors on UNIX 84
Index

previous releases 17
project databases
  closing 25
  logging into 20
  logging out of 25
  opening 20
  reviewing properties of 38
  selecting 35
  switching users 24
project pane 28
projects
  creating 10
  deleting 37
  logging into 22
  renaming 37
  reviewing properties of 38
  selecting 35
promotion group, lookup revision based on 57
promotion groups
  defining default 66
  filtering by 44
    Version Manager web client vs. desktop client 11
public vs. private workspace 62

R
recursive filtering of files 40
removing
  5.3/6.0 folders 37
  filters 51
  projects 37
  versioned files 37
renaming
  5.3/6.0 folders 37
  projects 37
reports
  difference 10, 70
  history 10
revision lookup behavior, defining 57
revision pane 30
revisions
  automatic branching 64
  comparing 70
  defining default 64
  getting 10
  locking 10
  selecting 35
  unlocking 10
root workspace 62

S
selecting
  project databases 35
  projects 35
  revisions 35
  versioned files 35
separator character for fields 55
Serena Merge Tool 76
Serena, contacting 8
setting
  number of items per page 55
  Version Manager web client options 54
  workfile location 63
  workspace properties 62
  workspaces 62
Single Sign On 22
SmartCard login 22
SourceBridge 15
specify a difference or merge tool 59
SSO login 22
status pane 34
subprojects, including 57
system requirements 18

T
target file, see output file 61, 76
TeamTrack 15
TrackerLink 13
typographical conventions 7

U
unlocking 10
user locks
  filtering by 40

V
version labels 10, 11
  filtering by 42, 43, 45, 47, 49
Version Manager web client
  and desktop client 11
  connecting to 20
  features 10
  options 54
  panes 28
Version Manager web client and previous releases 17
Version Manager web client vs. desktop client
  promotion groups 11
  version labels 11
versioned files
  comparing 70
  copying 11
  deleting 37
  filtering 39
  moving 36
  selecting 35
  viewing properties of 38
  viewing
Index

differences between files 70
files recursively 40

W

wildcard filename
  filtering by 41
workfiles
  adding 10
  comparing 70
  location 63
workspaces
  private 62
  public 62
  root 62
  setting 62